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1 Installation 
 

The current version of CADS Revit Scia Engineer Link works with both Revit Structure 
2013 and 2014. You will also need a copy of Scia Engineer to be installed on your system 
but it does not need to be authorised. CADS Revit Scia Engineer Link needs to know the 
version of Scia Engineer in order to create the correct version of the export file.  

 

For full details and the installation file for Revit Structure please go to 
http://www.cads.co.uk/revit_interface.html  and download the documents relating to the 
installation and use of the program in addition to this document.  

 

Documents Downloaded 

Release Notes This document details the supported versions of Revit Structure 
and Scia Engineer and the enhancements and bug fixes to the 
latest version of CADS Revit Scia Engineer Link. 

Getting Started CADS Revit Scia Engineer Link, configuration and basic usage 
notes. 

Check List Aide memoir when creating projects, this list should be submitted 
for all requests for support on CADS Revit Scia Engineer Link 

 

Please refer to this ‘Best practices’ document before installing or using the software. 

 

http://www.cads.co.uk/revit_interface.html
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2 Work Flow 
 

2.1 Revit Architecture Model to Scia Engineer Round Trip 
 

In the instance where you have to use a project created in Revit Architecture to create 
the Revit Structure model; it is advised that you use the Link Revit command and the 
Copy and Monitor feature to produce your own model in Revit Structure using the 
default Revit Structure template. This ensures that your model is defined correctly using 
Revit Structure elements as opposed to Architectural Concept Elements.  

 

Details on best practices for creating Revit Structure models are given later in this 
document. 

 

2.2 Revit Structure Model to Scia Engineer Round Trip 
 

Create your Revit Structure model based on the correct Revit Structure template for 
the code of practice you are using. This ensures that the model is created using Revit 
Structural elements and the Analytical model is enabled. The model that is exported 
from Revit Structure to Scia Engineer is based on the Analytical stick model and not the 
presentation model.  

 

Details on best practices for creating Revit Structure models are given later in this 
document. 

 

2.3 Scia Engineer to Revit Structure Round Trip 
 

Models created in Scia Engineer are based on the analytical centre line. When the 
model is transferred from Scia Engineer to Revit Structure the members will be 
transferred based on the analytical stick model created in Scia Engineer. Any offsets and 
eccentricities of members will be transferred wherever they are supported by the 
particular elements in Revit Structure. Where these offsets and eccentricities are not 
supported a warning message will be issued in the transfer log file in CADS Revit Scia 
Engineer link. These individual elements will need to have the eccentricities applied 
manually in Revit Structure to create the correct presentation model and corresponding 
general arrangement drawings.  
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Details on best practices for creating Scia Engineer models are given later in this 
document. 
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3 Creating the Revit Model 
 

Listed below are some best practice suggestions that will help optimise the transfer of 
the Revit Structure model to Scia Engineer. 

 

3.1 Revit Template 
 

You may use your customised Revit Structure template but ensure that the customised 
template is created from a default Revit Structure template deployed by Revit 
installation. The template used should be configured to use the same Units as that of 
the Scia Engineer model.  

 

 
Figure 1: Scia Engineer - Setup units 
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Figure 2: Scia Engineer - Units dialog 

 

It is recommended that you upgrade your customised template file when migrating to a 
higher version of Revit Structure. 

 

3.2 How to View the Analytical Model 
 

The model transfer to Scia Engineer is based on the Analytical Stick Model created in 
Revit Structure.  

 

You can view the analytical model in Revit Structure by going to the Properties dialog, 
selecting the Visibility and Graphics Overrides, then clicking on Edit and switching on the 
Analytical Model. 

 

If required you can disable the Model Categories to give a clearer view of the Analytical 
Model 
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Figure 3: Revit Structure - Visibility/graphics overrides 

 

3.3 Creating a Test Model 
 

Before using CADS Revit Scia Engineer link on a major project it would be wise to 
become familiar with the software by creating a test model. A few key points to look 
for: 

 

1. This model should incorporate the structural features you wish to specify in your 
projects so that it will allow you to test the round trip from Revit Structure to Scia 
Engineer and vice versa. For example, if you are using a custom Revit Structure 
family (*.RFA file) then it will be useful to create a member using the Revit Structure 
family (*.RFA file) and exporting it to Scia Engineer to check if the cross section type 
and member eccentricities are transferred correctly. 

 

2. Ensure that the analytical model is in the correct position and connected before 
attempting to export it to Scia Engineer. Please see the section below on Analytical 
Checks. CADS Revit Scia Engineer Link uses the Analytical Model in Revit Structure 
for exchanging models between Revit Structure and Scia Engineer. The analytical 
alignment can be adjusted in Revit Structure for all structural elements. The figure 
below shows an example of a Beam. 
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Figure 4: Revit Structure - Analytical properties 

 

 

3. Most importantly, make sure that the building you model in Revit structure is one 
that you could model in Scia Engineer and can be easily used for analysis. For 
example, if the members are not connected in Revit Structure then the same 
problem will be reflected in the Scia Engineer model too. Please refer to the figure 
below: 
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Figure 5: Analytical lines not connected in Revit Structure 

 

4. The Revit Structure model must be saved before exporting it to Scia Engineer. 

 

3.4 Levels  
 

Ensure that the Base Level and Top Level of columns & walls are set to the nearest Revit 
Structure Level. Otherwise Scia Engineer may not be able to resolve the position of the 
element correctly. If the vertical offsets (Top Offset and Base Offset) in Revit Structure 
are applied, do not allow them to cross another Level. Floor slabs should also be 
assigned to the nearest Level, otherwise analytical slab position in Scia Engineer will be 
incorrect.  

 

In the Revit Structure example shown below a separate level for the lift shaft roof was 
not created. The roof has been offset from Level 3 and the Analytical Floors setting was 
set at Projection -> Level 3. Whilst the presentation model is correct, the analytical 
model is incorrect and would be drawn on Level 3 when exported to Scia Engineer. This 
behaviour is sometimes observed when a Revit Structure file is migrated from the lower 
version to a higher version of Revit Structure. 

 

 

 

 

 

Revit Structure: Although these members 
appear to be joined, the analytical lines are not 
connected 

Scia Engineer: Members are transferred on 
the basis of analytical lines; hence, one of the 
members is not connected 



 

  12        

Best Practices 

 

 

 

 

  
Figure 6: Revit Structure - Difference between physical and analytical floor position 

 

The correct thing to do in this instance is to create another level above Level 3 with the 
Analytical Floors settings set to Auto-Detect and assigning the lift shaft roof to this level. 

 

3.5 Offset Framing & Column Members 
 

3.5.1 Vertical Offsets 

 

The vertical offsets for beams can be provided in several ways. Two different cases and 
their implications are described below. It is always useful to agree with the Structural 
Engineer on the preferred method of modelling to ensure minimum rework is required 
by the Structural Engineer in Scia Engineer. 

 

Case 1: Vertical offset using Z offset value in Revit Structure 

In this case, a beam is drawn in the floor level, aligned with other beam and column top 
positions, but offset by 300 mm using the Revit Structure properties.  

 

Lift shaft roof slab - graphically correct with 
offset from Level 3 

Lift shaft roof slab - analytically incorrect 
and assigned to Level 3 
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Figure 7: Revit Structure - Vertical offset provided with z Offset Value 

CADS Revit Scia Engineer Link transfers the model to Scia Engineer based on the 
Analytical lines. Hence the analysis model in Scia Engineer will be as shown below: 

 

 

 

 

  

Figure 8: Scia Engineer - Vertical offset case 1 

 

Rendered Model Stick Model 
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Case 2: Vertical offset by drawing the beam in position 

In this case the beam is drawn in place by creating a work plane in Revit Structure 
instead of specifying an offset from the floor level. Although the physical position of the 
beam is the same as that described in Case 1, Revit Structure automatically adjusts the 
analytical line for the beam to align with the top of beam. 

 

  

Figure 9: Revit structure - Beam drawn in place with Z Offset Value = 0 

  The analysis model transferred to Scia Engineer in this case will be as shown below: 

 

   

Figure 10: Scia Engineer - Vertical offset case 2 

 

Rendered Model Stick Model 
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The physical locations of the beam in both cases were identical, but owing to the 
difference in the analytical line position the model transferred to Scia Engineer was 
different.  

 

3.5.2 Lateral offsets 

 

Lateral offsets are allowed only for beams and braces in Revit Structure. This feature is 
enhanced in the Revit Structure 2014 version; hence the recommendation is given in 
two sections, one for Revit Structure 2013 and lower versions and the other for the 
Revit Structure 2014 version. 

Note that there is no provision to offset columns from its local reference axes in Revit 
Structure. The implications are elaborated in the Eccentricities section. 

 

Revit Structure 2013 and lower versions: 

Revit Structure restricts you to three lateral justifications for framing elements, Side 1, 
Side 2 and Centre. Scia Engineer, however will allow you to offset laterally beyond the 
boundary of the section. The structural model is transferred based on the analytical 
lines defined in Revit Structure. Therefore if you physically move the member in Revit 
Structure to achieve the required lateral offset, you may not get the desired result in 
Scia Engineer. For example: 

 

 
 

 

Figure 11: Lateral offset between Revit Structure 2013 and Scia Engineer model 

Therefore to overcome this limitation in Revit Structure, it would be a better idea to 
model as above in Revit Structure and change the eccentricities manually in Scia 
Engineer.  

Revit Structure 2013 and lower 
versions: Beam with lateral offset = 
Side 1  

Scia Engineer: Beam is aligned as per 
the Analytical line in Revit Structure  



 

  16        

Best Practices 

In order to avoid overwriting the changes made to Scia Engineer during the subsequent 
export to Revit Structure you may set the CADS Revit Scia Engineer Link option 
Overwrite = No. Please refer to section 5.3 of the Getting Started guide for more details. 

 

Revit Structure 2014 version: 

The lateral offsets can be applied to beam and braces in Revit Structure 2014 and are 
mapped appropriately in Scia Engineer.  

 
 

 

Figure 12: Lateral offset between Revit Structure 2014 and Scia Engineer model 

3.5.3 Eccentricities 

In the Revit Structure model you might be required to align framing elements to one 
face over several stories. An example of this would be walls of different thicknesses and 
concrete columns of different section sizes. Revit Structure will automatically adjust the 
analytical stick model to align them together whilst keeping the presentation model 
correct. These eccentricities are correctly exported to Scia Engineer. If the section 
properties are not changed in Scia Engineer and the model is exported back to Revit 
Structure, the framing members will keep the original alignment in Revit Structure. 
Otherwise, they will need to be adjusted manually in Revit Structure to ensure the 
presentation model is correct. You can track amendments to your Revit Structure 
model using the Select Changes option, which will highlight the changes in geometry, 
section size and material type as well as new elements that have been added. Please 
refer to the section on this command at the end of the document. 

 

In the example given below, a three storey high wall is modelled in Revit Structure. The 
analytical line is automatically aligned based on the centre line of the top column (may 
vary depending on how the wall is modelled) 

CADS Revit Scia Engineer link will transfer the model based on the Analytical lines. Thus 
columns will be aligned as shown below: 

 

Revit Structure 2014: Beam with 
lateral offset, Y Offset Value = 
250mm 

Scia Engineer: Beam with lateral offset, 
ey = 250mm 
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Figure 13: Wall aligned to outer edge with Auto-Detect analytical lines in Revit Structure 

 

Another alternative is to manually change the analytical line position using Revit 
Structure feature for each wall position. 

          

 

Figure 14: Wall aligned to outer edge with manually adjusted analytical lines in Revit Structure 

The walls are still physically aligned to the left edge but the analytical line is present at 
the centre line of each wall storey. In this case, CADS Revit Scia Engineer Link will 
transfer the model to Scia Engineer to match the physical location of wall in Revit 
Structure as above but the nodes at each storey level will be disconnected.  

 

Revit Structure: Wall 
aligned to outer edge with 
Auto-Detect analytical 
lines 

Scia Engineer: Wall aligned 
as per analytical lines 

Revit Structure: Wall 
aligned to outer edge with 
analytical lines manually 
adjusted to centreline of 
each wall storey 

Scia Engineer: Wall 
aligned to outer edge 
resulting in nodes not 
connected at each floor 
level  
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The adjustment made to Scia Engineer model will not be overwritten by CADS Revit 
Scia Engineer Link in a subsequent update if the member to which the adjustment is 
made is not changed in Revit Structure. For example, the structural engineer may 
provide eccentricity for Wall 1 in Scia Engineer, in a subsequent update from Revit 
Structure the eccentricity in Wall 1 will be retained as long as the Wall 1 is not changed 
in Revit Structure.   

 

3.6 Enable Analytical Model 
 

Ensure that any structural member you want to export to Scia Engineer has the option 
Enable Analytical Model ticked in the Revit Structure Properties dialog. You may also 
have to enable the structural model on some elements. 

 

 
Figure 15: Revit Structure - Enable Analytical Model 

3.7 Zero Length Elements 
 

If there are elements on the model which have no physical length, CADS Revit Scia 
Engineer Link will flag them in the log file while exporting the model to Scia Engineer. 
You need to remove them from the model before trying to export to Scia Engineer.  

 

3.8 Openings in Slabs or Walls 
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Where an opening coincides with the edge of a slab or a wall it is the best practice to 
define the boundary of the slab around the opening. 

When a hole is required within the perimeter of a slab or wall do not use the edit 
boundary option to add the hole.  

 

Figure 16: Revit Structure – Slab openings 

 

Owing to application limitations it is not possible to import changes to the slab 
boundary in Scia Engineer if the number of nodes is modified. It is the best practice to 
use the Opening option whenever possible. 

3.9 Dummy Elements 
 

A dummy element is a short piece of structure.  Rather than use a small element, join 
the awkward connections with either model or detail lines. Dummy elements will not be 
exported from Revit Structure to Scia Engineer and will be shown in the transfer log file.  
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4 Checking the Model 
 

The following lists the checks you should carry out prior to exporting the model to Scia 
Engineer. 

 

4.1 Analytical Checks  
 

In the Structural Settings dialog under the Analytical Model Settings tab you can activate 
the automatic checks for Member Supports and Analytical/Physical Model Consistency. 
This will mean that Revit Structure will automatically adjust your model and check for 
inconsistencies.  

 

 
Figure 17: Revit Structure - Structural settings 

 

In case you prefer to apply these checks manually leave them unchecked and when you 
are ready, run the Check Supports and Consistency Checks from the Analyze Tab. 
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Figure 18: Revit Structure – Analysis check options 

4.2 Check Supports  
 

The Member Support check will warn and highlight any unsupported elements within 
the model. You can choose to show or delete the check elements depending on the 
warning you get. If you use the show option you can adjust the properties of the 
element as required. 

 

  
Figure 19: Revit Structure - Warnings 

You can access these Warnings once the dialog has been closed by going to the Manage 

tab – Inquiry panel and selecting Warnings . 

4.3 The Analytical/Physical Consistency Check  
 

The criteria set in the Structural Settings dialog is applied to your model and you are 
warned where the model does not comply. These errors need to be corrected before 
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exporting the model to Scia Engineer. You can use the Show button to highlight the 
element or use the Revit ID number to locate it using the Select by ID on the Modify Tab.  
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5 Configuration Settings 
 

The settings applied inside the Revit Structure to CADS Revit Scia Engineer Link will 
affect the way the model is transferred between Revit Structure & Scia Engineer. 

 

5.1 Options  
Generally the settings inside the Options dialog box should be set-up as follows with a 
few exceptions that are explained below: 

 

 

Figure 20: CADS Revit Scia Engineer Link - Options dialog 

 

5.2 Export Selected Items Only 
 

Generally you will be exporting/importing the whole model to and from Scia Engineer. 
On some occasions you may only want to export part of the structure, select the option 
Export Selected Items Only and the link will only export the items selected in Revit 
Structure to Scia Engineer. 
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Figure 21: CADS Revit Scia Engineer Link - Export Selected Items Only 

 

Note that this option works only when exporting the model from Revit Structure to Scia 
Engineer.  

 

5.3 National Code  
 

Make sure that the National Code in CADS Revit Scia Engineer Link matches the 
National Code set in Revit Structure and Scia Engineer. The National Code depends on 
the Scia Engineer Version selected. 
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5.4 Scia Engineer Version  
 

You will not be able to use the link software unless you configure the version of Scia 
Engineer that is installed on your system. Click on the field and browse to the location 
of your ESA.EXE file which is usually located in your C:\Program 
Files\SCIA\Engineer20xx.x folder”.  

 

 
Figure 22: CADS Revit Scia Engineer Link - Scia Engineer version  

 

5.5 Launch Scia Engineer  
 

If you have an authorised copy of Scia Engineer on your system, setting this option to 
Yes will mean that Scia Engineer will be automatically started and your model will be 
loaded into the program. Setting the option to No will mean that a transfer file will be 
created in the same folder as your Revit Structure model unless you specify a different 
location. The transfer file will have the extension *.R2S. The transfer file can be opened 
inside Scia Engineer using either the File-> Import option or the File -> Update option.  

 

5.6 Preferred Tables  
 

It is recommended that you move the preferred section databases you would like the 
link to use to the top of the list. 
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Figure 23: CADS Revit Scia Engineer Link - Preferred Database 

5.7 Mapping Rules  
 

Set both the Cross Section and Material to “Use if Not found”. This means that if CADS 
Revit Scia Engineer Link encounters a section or material not currently configured in its 
databases you will be prompted to choose a suitable section from the tables. 

 

5.8 Revit Family Path  
 

If your installation of Revit Structure does not have the families installed in the default 
location on your hard drive you can use this option to configure the path to the libraries. 
The default location for the families on your hard drive is 
C:\ProgramData\Autodesk\RST 20xx\Libraries\UK.  

 

5.9 User Tables  
 

On first use of the link these tables will be blank. They will contain the user defined 
mappings for cross sections and materials that are not in the default tables. 
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5.10 Mapping Tables 
 

This dialog, details the default mapping tables that are shipped with the CADS Revit Scia 
Engineer Link. It illustrates the default Revit Structure cross sections linked to the 
corresponding default Scia Engineer sections. Any changes of name from the default 
Revit Structure cross section name will result in you being prompted to define the 
mapping yourself. These mappings will then be added to the User Table. 

 

 
Figure 24: CADS Revit Scia Engineer Link - Mapping Tables 

 

For full details on all the settings in the CADS Revit Scia Engineer Link Options dialog 
refer to the Getting Started Guide and the Help file. 
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6 Export/Import Tools 
 

Purge and save the model. The purge command is available from the Manage tab and 
will help reduce the size of the Revit Structure model. 

 

On the first attempt to export the model to Scia Engineer after you have checked the 
analytical model, it is recommended that you open the Options dialog and check the 
configuration settings as explained in Section 5 above. 

 

Then select the Export to Scia Engineer button . 

 

 

 

The Log dialog will be displayed and CADS Revit Scia Engineer Link will read the Revit 
Structure model, and make a list of the total number of items from each category to be 
exported. 

 

When CADS Revit Scia Engineer Link encounters a material that is not in the material 
table you will be prompted as follows; 
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Figure 25: CADS Revit Scia Engineer Link - Material Mapping 

 

To add this material to your User Table: Material answer Yes. 

 

 
Figure 26: CADS Revit Scia Engineer Link - Add Material Mapping to User Table 

 

Select the appropriate Scia Engineer Material Name from the list and click OK. 

When CADS Revit Scia Engineer Link encounters a section that is not in the section 
tables you will be prompted as follows; 

 

 
Figure 27: CADS Revit Scia Engineer Link - Cross Section Mapping 

 

To add this section to your User Table: Section answer Yes. 
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Figure 28: CADS Revit Scia Engineer Link - Add Cross Section to the User Table 

 

On completion of the export routine, the Log dialog shows a summary of the number of 
items exported. You can save a log file which can be opened in a text editor to review 
the transfer. 

 

 
Figure 29: CADS Revit Scia Engineer Link - Model exchange log 

6.1 Filter 
 

The filter option will allow you to locate any elements in the Revit model that have not 
been exported to Scia Engineer.  
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Figure 30: CADS Revit Scia Engineer Link - Filter - Non Exported Items 

Tick the elements you want to review and then click the show option; they are 
highlighted in your Revit Structure model. 

 

6.2 Log Files 
 

The Log file is a text file which itemises each element that has been transferred 
between Revit Structure and Scia Engineer. It details the section / material and its 
mapping. Any elements that have not been successfully transferred are shown in red. At 
the end of the transfer of the model from Revit Structure to Scia Engineer and vice 
versa you are given the option to save this file and review it.  

 

The Log file will show the Revit ID number of an element that has not been transferred 
to/from Scia Engineer. You can use the Select by ID command (Manage Tab) to highlight 
and investigate these elements in the Revit Structure.  

 

6.3 Select Changes 
 

This option will help you to review any changes that have been made to the Revit 
Structure model when you import the model from Scia Engineer. The diagram below, 
shows the increased section size of the concrete column. Choosing the Section Size 
option on the Select Changes command will highlight the amended column in Revit 
Structure.  
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Figure 31: CADS Revit Scia Engineer Link - Select Changes 

 

6.4 Import/Export Limitations 
 

Refer to the Help pages in CADS Revit Scia Engineer Link for the full list of items 
supported & unsupported in Revit Structure and the corresponding items in Scia 
Engineer. Also shown is a table of how physical Revit Structure objects are transferred 
between Revit Structure and Scia Engineer. Refer to the topic on the Bi Directional Link 
between Revit and Scia Engineer. 

 


